Tad and Adam,

Does this happen when assigning from a particular layer?

Is this with all your plans (New, Existing or one's created from a template)? Do the plans have spaces or special characters in their name?

I have been trying hard to recreate the error and I may need some more information.

Thank you,

Tony

From: tottman [mailto:]
Sent: Wednesday, May 04, 2011 10:23 AM
To: Squires, Ryan
Subject: Autobound crash

Ryan,

This is a picture of what I get when autobound crashes on me. I was working on a map that has effectively 8 Assembly Districts assigned, I clicked on "current district" on the autobound tools to switch districts. The district numbers came up, when I clicked on the new district I wanted to move to, the program crashed and closed out and this popped up: (If form holds, this will happen on nearly every district switch using the toolbar the rest of the way until I have them all filled in and can left click between districts)
ArcGIS Desktop has encountered a serious application error and is unable to continue.

If you were in the middle of something, the information you were working on might be lost.

Please tell ESRI about this problem.

We have created an error report. Press the 'Send Error Report' button to send the error report to us automatically over the internet.

We will treat this report as confidential and anonymous.

Optionally, provide your email address and a description of the problem. We will contact you if we need additional information about this issue. Your email will only be used in relation to this issue.

Email Address:

What were you doing when the problem happened?

☑ Include my system information in the error report

Send Error Report  Don't Send
Tad Ottman <tottman@gmail.com>

MALDEF
2 messages

Jim Troupis <jrtroupis@trouplawoffice.com>  Tue, Jul 12, 2011 at 3:32 PM
To: tottman <tottman@gmail.com>, adamfoltz@gmail.com
Cc: "McLeod, Eric M (22257)" <EMMcLeod@michaelbest.com>, rptaffora@michaelbest.com

Troupis Law Office LLC
7609 Elmwood Ave
Suite 102
Middleton, WI 53562
608.807.4096
jrtroupis@trouplawoffice.com

This email and any attachments thereto may contain private, confidential and privileged material for the sole use of the intended recipient. Any review, copying, or distribution of this email (or any attachments thereto) by others is strictly prohibited. If you are not the intended recipient, please contact the sender immediately and permanently delete the original and any copies of this email and any attachments thereto.

tottman <tottman@gmail.com>  Tue, Jul 12, 2011 at 3:43 PM
To: Jim Troupis <jrtroupis@trouplawoffice.com>
Cc: adamfoltz@gmail.com, "McLeod, Eric M (22257)" <EMMcLeod@michaelbest.com>, rptaffora@michaelbest.com


This email and any attachments thereto may contain private, confidential and privileged material for the sole use of the intended recipient. Any review, copying, or distribution of this email (or any attachments thereto) by others is strictly prohibited. If you are not the intended recipient, please contact the sender immediately and permanently delete the original and any copies of this email and any attachments thereto.

From: Elisa Alfonso [mailto:elafonso@MALDEF.org]
Sent: Monday, July 11, 2011 4:50 PM
To: 'Jim Troupis'
Cc: Alonzo Rivas
Subject: FW: MALDEF WI House Plan, (2nd edition)

Jim,

As promised, here is the MALDEF map we discussed this afternoon.
If you have any questions, please let us know.

Elisa

---

**WI_House_MALDEF_Plan2.zip**

314K

---

**totman <totman@gmail.com>**

To: Jim Troupis <jrtroupis@troupislawoffice.com>
Cc: adamfoltz@gmail.com, "McLeod, Eric M (22257)" <EMMcleod@michaelbest.com>, rptaffora@michaelbest.com

Mon, Jul 11, 2011 at 5:35 PM

---

**Jim Troupis <jrtroupis@troupislawoffice.com>**

To: totman <totman@gmail.com>
Cc: adamfoltz@gmail.com, "McLeod, Eric M (22257)" <EMMcleod@michaelbest.com>, rptaffora@michaelbest.com

Mon, Jul 11, 2011 at 5:41 PM
Troupis Law Office LLC
7609 Elmwood Ave
Suite 102
Middleton, WI 53562
608.807.4096
jrtroupis@troupislawoffice.com

This email and any attachments thereto may contain private, confidential and privileged material for the sole use of the intended recipient. Any review, copying, or distribution of this email (or any attachments thereto) by others is strictly prohibited. If you are not the intended recipient, please contact the sender immediately and permanently delete the original and any copies of this email and any attachments thereto.

From: totman [mailto:tottman@gmail.com]
Sent: Monday, July 11, 2011 5:35 PM
To: Jim Troupis
Cc: adamfoltz@gmail.com; McLeod, Eric M (22257); rpta@michbest.com
Subject: Re: FW: MALDEF WI House Plan, (2nd edition)

[Quoted text hidden]

tottman <tottman@gmail.com> Mon, Jul 11, 2011 at 5:57 PM
To: Jim Troupis <jrtroupis@troupislawoffice.com>
Cc: adamfoltz@gmail.com, "McLeod, Eric M (22257)" <EMMcLeod@michbest.com>, rpta@michbest.com

Jim Troupis <jrtroupis@troupislawoffice.com> Mon, Jul 11, 2011 at 6:42 PM
To: totman <tottman@gmail.com>, adamfoltz@gmail.com, "McLeod, Eric M (22257)" <EMMcLeod@michbest.com>, rpta@michbest.com
Elisa and Alonzo,

I like your proposal. We’ve taken it a bit further. Here is a comparison of MALDEF’s proposal to a suggestion we think might work a bit better. MALDEF’s option is shown in color and our suggestion to do the same thing on the same template is shown in outline form as an overlay.

The HVAP numbers under the 2 plans:

MALDEF

AD 8 60.10
AD 9 53.00

Our Alternative

AD 8 60.52
So this takes the same principal and improves it slightly on the numbers. Importantly, the MALDEF proposal would result in changing at least four other assembly districts in the present legislation, while this alternative would not cause those other unnecessary changes. As a result, I think the legislature could move to your suggestion—with our small changes.

Let us know what you think.

The hearing is on Wens., and if you would be willing to speak on behalf of this, we can then make sure you are on the agenda and the plan is given complete consideration.

Jim

Troupis Law Office LLC
7609 Elmwood Ave
Suite 102
Middleton, WI 53562
608.807.4096
jrtroupis@troupislawoffice.com

This email and any attachments thereto may contain private, confidential and privileged material for the sole use of the intended recipient. Any review, copying, or distribution of this email (or any attachments thereto) by others is strictly prohibited. If you are not the intended recipient, please contact the sender immediately and permanently delete the original and any copies of this email and any attachments thereto.

---

From: Elisa Alfonso [mailto:ealfonso@MALDEF.org]
Sent: Monday, July 11, 2011 4:50 PM
To: 'Jim Troupis'
Cc: Alonzo aRivas
Subject: FW: MALDEF WI House Plan, (2nd edition)

Jim,

As promised, here is the MALDEF map we discussed this afternoon.
If you have any questions, please let us know.

Elisa

Jim Troupis <jrtroupis@troupislawoffice.com>
To: totman@gmail.com, adamfoltz@gmail.com, "McLeod, Eric M (22257)" <EMMcleod@michaelbest.com>, rptaflora@michaelbest.com

James R. Troupis
Troupis Law Office LLC
jrtroupis@troupislawoffice.com
ph. 608-807-4096

This email and any attachments thereto may contain private, confidential and privileged material for the sole use of the intended recipient. Any review, copying, or distribution of this email (or any attachments thereto) by others is strictly prohibited. If you are not the intended recipient, please
contact the sender immediately and permanently delete the original and any copies of this email and any attachments thereto.

From: Elisa Alfonso [mailto:ealfonso@MALDEF.org]
Sent: Tuesday, July 12, 2011 11:41 AM
To: Jim Troupis; Alonzo Rivas
Subject: Re: FW: MALDEF WI House Plan, (2nd edition)

Jim,
Alonzo is out this morning and won't be back until this afternoon.

In regards to the MALDEF map, we will go with the recommendation you made last night.

As for tomorrow, we are unfamiliar with the process. Does it have to be oral testimony or can it be written? Any suggestions you can give us will be greatly appreciated.

We definitely need to speak today. Please let us know when you think we can have a call after your meetings.

Thank you.

Sent via BlackBerry by AT&T

From: Jim Troupis <jrtroupis@troupislawoffice.com>
Date: Tue, 12 Jul 2011 10:35:56 -0500
To: Elisa Alfonso<ealfonso@MALDEF.org>; Alonzo Rivas<Arivas@MALDEF.org>
Subject: RE: FW: MALDEF WI House Plan, (2nd edition)

Elisa,

I am meeting with legislative leaders this afternoon. Can we talk later this morning? The hearing will be tomorrow at 10 a.m. in Madison, and so, to the extent we can, we would like to insure that the concerns of the Latino community are addressed. This morning I asked staff to consult with our Legislative Reference Bureau on these alternatives as they must ultimately draft any amendment.

Let me know what works.

Jim

James R. Troupis
Elisa and Alonzo,

I like your proposal. We’ve taken it a bit further. Here is a comparison of MALDEF’s proposal to a suggestion we think might work a bit better. MALDEF’s option is shown in color and our suggestion to do the same thing on the same template is shown in outline form as an overlay.

The HVAP numbers under the 2 plans:

MALDEF

AD 8 60.10
AD 9 53.00

Our Alternative

AD 8 60.52
AD 9 54.03

So this takes the same principal and improves it slightly on the numbers. Importantly, the MALDEF proposal would result in changing at least four other assembly districts in the present legislation, while this alternative would not cause those other
unnecessary changes. As a result, I think the legislature could move to your suggestion—with our small changes.

Let us know what you think.

The hearing is on Wens., and if you would be willing to speak on behalf of this, we can then make sure you are on the agenda and the plan is given complete consideration.

Jim

Troupis Law Office LLC
7609 Elmwood Ave
Suite 102
Middleton, WI 53562
608.807.4096
jrtroupis@troupislawoffice.com

This email and any attachments thereto may contain private, confidential and privileged material for the sole use of the intended recipient. Any review, copying, or distribution of this email (or any attachments thereto) by others is strictly prohibited. If you are not the intended recipient, please contact the sender immediately and permanently delete the original and any copies of this email and any attachments thereto.
1. Create a new plan  
2. Empty plan  
3. Open arcmap  
4. Add data  
5. Ap9gbd  
6. open arc toolbox  
7. conversion tools  
8. open to shapefile  
9. feature class to shapefile  
10. input features (plan boundary)  
11. output folder, wherever you want  
12. Go to data exchange tools  
13. Import plan
Tad and Adam,

an you look at this report to see if the structure works for you.

Thank you,

Tony

Tony J. Van Der Wielen
Legislative Technology Services Bureau
GIS Manager
Phone: 608-283-1817
Fax: 608-267-6763
E-mail: Tony.vanderwielen@legis.wisconsin.gov
### Disenfranchisement Report

**5/20/2011**

#### Current District: 5

<table>
<thead>
<tr>
<th>Population from District</th>
<th>8</th>
<th>1,517</th>
<th>1,841</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Disenfranchised:</td>
<td>32,664</td>
<td>41,425</td>
<td></td>
</tr>
</tbody>
</table>

#### Current District: 25

<table>
<thead>
<tr>
<th>Population from District</th>
<th>12</th>
<th>6,507</th>
<th>8,256</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Disenfranchised:</td>
<td>6,507</td>
<td>8,256</td>
<td></td>
</tr>
</tbody>
</table>

#### Current District: 29

<table>
<thead>
<tr>
<th>Population from District</th>
<th>12</th>
<th>4,069</th>
<th>4,832</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Disenfranchised:</td>
<td>4,069</td>
<td>4,832</td>
<td></td>
</tr>
</tbody>
</table>

#### Current District: 33

<table>
<thead>
<tr>
<th>Population from District</th>
<th>28</th>
<th>749</th>
<th>968</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Disenfranchised:</td>
<td>749</td>
<td>968</td>
<td></td>
</tr>
</tbody>
</table>

**Total for Plan:** Workspace: Senate Plans>>SimpleSenate2

| 43,989 | 55,481 |
I just want to confirm it works with the Senate District Plans. I am still working on the Assembly side.

Tony

-----Original Message-----
From: Ottman, Tad
Sent: Monday, May 23, 2011 5:17 PM
To: Van Der Wielen, Tony
Subject: RE: Disenfranchisement

I finally got the disenfranchise report to run, but it was off by a 6 figure magnitude compared to the same core constituency report on a senate plan. Some totals from even numbered senate districts it had dead on, others were off by 100's to 1000's, and in still others, it missed complete totals from even numbered senate districts that wound up in odd numbered districts.

-----Original Message-----
From: Van Der Wielen, Tony
Sent: Fri 5/20/2011 3:53 PM
To: Ottman, Tad; Foltz, Adam
Subject: Disenfranchisement

Tad and Adam,

Can you look at this report to see if the structure works for you.

Thank you,

Tony

Tony J. Van Der Wielen  
Legislative Technology Services Bureau  
GIS Manager  
Phone: 608-283-1817  
Fax: 608-267-6763  
E-mail: Tony.vanderwielen@legis.wisconsin.gov
I will look at this now.

"sent from my iPhone"

On May 23, 2011, at 5:16 PM, "Ottman, Tad" <Tad.Ottman@legis.wisconsin.gov> wrote:

> I finally got the disenfranchisement report to run, but it was off by a 6 figure magnitude compared to the same core constituency report on a senate plan. Some totals from even numbered senate districts it had dead on, others were off by 100's to 1000's, and in still others, it missed complete totals from even numbered senate districts that wound up in odd numbered districts.
>
> -----Original Message-----
> From: Van Der Wielen, Tony
> Sent: Fri 5/20/2011 3:53 PM
> To: Ottman, Tad; Foltz, Adam
> Subject: Disenfranchisement
>
> Tad and Adam,
> 
> Can you look at this report to see if the structure works for you.
>
> Thank you,
> 
> Tony
> 
> Tony J. Van Der Wielen
> Legislative Technology Services Bureau
> GIS Manager
> Phone: 608-283-1817
> Fax: 608-267-6763
> E-mail: Tony.vanderwielen@legis.wisconsin.gov <mailto:Tony.vanderwielen@legis.wisconsin.gov>
I would try and do a recalculation of the plan and choose “no”. This should help.

I am looking into this further today.

Tony

Tony J. Van Der Wielen
Legislative Technology Services Bureau
GIS Manager
Phone: 608-283-1817
Fax: 608-267-6763
E-mail: Tony.vanderwielen@legis.wisconsin.gov
Hi Tad and Adam,

We will be clipping the Great Lakes and Lake Winnebago water from the entire Statewide10 database so the compactness and other spatial analysis will be accurate. The exact blocks that were chosen as “Land” or “Water” were determined by population counts (all being 0), the US Census Water layer/codes, and by Tony and I confirming each of them by hand. In the frequent case of a river running into the lakes, the blocks were removed in the river outlet up until the first bridge.

The process is quite simple. We will be using the State outline I described above as a cookie cutter to clip out the water from the data. There will be no loss of population, and the data will be exactly the same as before, but there will be blocks removed. Since we drew the outline based on the same blocks that you are using, there shouldn’t be any trimming of actual polygons at the block level, only removal. However, we will have to trim the geography of all of the higher level geographies, so the process takes about an hour to complete. The process creates a copy, and does not alter the original database, so we can test it before we leave.

Please let us know when would be the best time for Tony and I to come over and start the process or if you have any questions.

Thanks,

Ryan Squires
GIS Analyst
Legislative Technology Services Bureau
608-283-1814
Tad and Adam,

Can you run through the following steps in autoBound. This will prepare your database for the 2010 State Senate Election Data.

1. Open the autoBound Administration tool.
   a. Choose “Manage my Census and Political Data”.
   b. Choose “Calculate or Edit My Database”.
   c. Click on the “Add Field” button.
   d. Add the following fields with the following parameters
      1. Numeric
      2. Field 9, no decimals
      ii. SSDEM10
      iii. SSREP10
      iv. SSIND10
      v. SSSCAT10
      vi. SS10T

After the fields are added you may need to “Finalize database” to use autoBound again. If this can be done before we come over tomorrow, I will be able to add the 2010 Senate data to your databases.

If you don’t feel comfortable adding these fields in the database I can do it tomorrow.

Thank you,

Tony
Tony J. Van Der Wielen
Legislative Technology Services Bureau
GIS Manager
Phone: 608-283-1817
Fax: 608-267-6763
E-mail: Tony.vanderwielen@legis.wisconsin.gov
Hi Tad and Adam,

I spoke with Fred on the phone. The slivers showing up in the Plan Errors and the Overlapping Populations error are directly related as you suspected. Without going into too much unnecessary detail, the issue is basically due to the differences in precisions between the native format (shapefiles) that the original data sits in, and the database format that it is converted to when a plan is generated. I guess this is an issue that Fred has been working on for a while and was able to find a resolution last week. He has released a patch on his website. However there are two things you should be aware of. The first is that we have not tested this new patch yet, so you can download and run it now, or let us download and mess with it a bit to test it. It is up to you, I didn’t know how much it was affecting you, or if you are ok with trusting the patches. The second is that this will only affect NEW plans, so all of your previously created plans will not be fixed. Fred promised me he would create a utility in the next couple of days to convert old plans into the patch solution. He will let me know when that is released.

You can find the patch (autobound10_P5.exe) on Fred’s website here:

http://citygategis.com/download/

In regards to the third issue about AutoBound crashing when you click on Current District or Active Layer, Fred informed me that he has not ever seen the issue or heard of any other users with the issue thus far. We have not seen the issue here, so it was hard for me to push him too hard on it. I think to resolve it, we are going to have to document the conditions and procedures around the crash. The next time that it happens, could you please take a screen shot of the error, give me a step by step procedure of what was clicked leading up to the crash, and some information on the plan you were working on at the time.

Please let me know if you have any other questions.

Thanks,

Ryan Squires
GIS Analyst
Legislative Technology Services Bureau
608-283-1814
Hi Adam and Tad,

I have been trying to track down the US Representatives’ home addresses for the Congressional Incumbents file that you had requested, but due to security reasons, it has been quite difficult to get any information. Mike Keane was able to dig up the addresses below, but it sounds like they are about a year old, or 12 years old in the case of Baldwin. Would you like me to go ahead with these addresses, or do you know of any other person to contact that would have this information? Please see the email below.

Thanks,

Ryan Squires

---

From: Keane, Michael  
Sent: Wednesday, May 11, 2011 10:08 AM  
To: Van Der Wielen, Tony; Squires, Ryan  
Subject: Addresses of Congressmen.

These are the addresses we have for Representative to Congress from Wisconsin. For the most part, they are the information submitted to the GAB when they filed for candidacy in July 2010, so they should be considered old data. In the case of Baldwin, the most recent address we have is from 1999, although she may still live there.

Ryan: 221 East Holmes Street, Janesville 53545  
Baldwin: 525 Riverside Drive, Madison 53704  
Kind: 3061 Edgewater Lane, La Crosse 54603  
Moore: 4043 North 19th Place, Milwaukee 53209  
Sensenbrenner: N76 W14726 North Point Drive, Menomonee Falls 53052  
Petri: N5329 DeNeveu Lane, Fond du Lac 54937  
Duffy: 2906 City Heights Road, Ashland 54806  
Ribble: 1959 Schuering Road, De Pere 54115

If you have any questions, let me know.

Mike Keane  
LRB  
6-0346
Hi Adam and Tad,

Tony mentioned you were looking for this map. You should be able to print this off on your plotter.

If you have any questions, please let either me or Tony know.

Thank you,

Dana
Voting Age Populations

1 message

tottman <tottman@gmail.com>  Tue, Jul 12, 2011 at 5:00 PM
To: prospectre <prospectre@aol.com>, rspindell <rspindell@gottesman-company.com>, gerardmdll@yahoo.com

Attached is the file with Voting populations from the court drawn map in 2002. The African-American districts we are talking about are Assembly districts 10, 11, 12, 16, 17 and 18. The Hispanic districts are Assembly districts 7, 8 and 9.

AD's 10, 11 and 12 make up the 4th senate district, 16,17 and 18 make up the 6th Senate district, and 7, 8 and 9 make up the 3rd Senate district.

Under SB 148, below are listed the Voting Age Percentages.

AC 10 (Coggs) 61.8%
AC 11 (Fields) 61.9%
AC 12 (Open) 51.5%

SD 4 (Taylor) 58.4%

AD 16 (Young) 61.3%
AD 17 (Toles) 61.3%
AD 18 Grigsby) 60.4%

SD 6 (Coggs) 61%

Please let me know if you have any questions.

Tad Ottman
Hi Tony,

We're hoping for early March but that's subject to whether we're open or not--if we're shut down--it's then how long are we shut down.

Cathy

Cathy McCully, Chief
Census Redistricting Data Office

301-763-4039
fax 301-763-4348
cell-301-467-4845
catherine.clark.mccully@census.gov
Cathy,

I hope all is going well.

I have been checking the RDO website and I can see we are not scheduled for this week. Could you give me any insight on the delivery of the PL data to Wisconsin?

Thank you!

Tony

---Original Message---
From: catherine.clark.mccully@census.gov
[mailto:catherine.clark.mccully@census.gov]
Sent: Friday, January 14, 2011 6:46 AM
To: Van Der Wielen, Tony
Subject: RE: PL and TIGER Data

Hi Tony,

We will be shipping Wisconsin on Tuesday by next day Fed-Ex. You should have it next Wednesday. It will be posted to the web on Thursday. Have you been watching our web site? You can track progress by going to the www.census.gov/rdo/data Products are listed in the left hand column and by clicking each product you get a description and status report.

We're updating the site right now.

Cathy
*****************************************
Cathy McCully, Chief
Census Redistricting Data Office

301-763-4039
fax 301-763-4348
cell 301-467-4845
catherine.clark.mccully@census.gov

From: "Van Der Wielen, Tony"
<Tony.VanDerWielen@legis.wisconsin.gov>

To: <catherine.clark.mccully@census.gov>

Date: 01/13/2011 05:12 PM
Subject: RE: PL and TIGER Data

Cathy,

Do you have any information on the release of our TIGER data or our PL data?

We are getting a little nervous that we are last on the list to get data.

We have some tight deadlines for our local redistricting project and I am getting pressed for any word on delivery of our data.

Any information would be most appreciated.

Thank you,

Tony

Tony J. Van Der Wielen
Legislative Technology Services Bureau
GIS Manager
Phone: 608-283-1817
Fax: 608-267-6763
E-mail: Tony.vanderwielen@legis.wisconsin.gov
Wisconsin Interactive Map Server: http://wims.legis.state.wi.us

From: Van Der Wielen, Tony
Sent: Monday, November 22, 2010 10:31 AM
To: catherine.clark.mccully@census.gov
Subject: PL and TIGER Data

Cathy,

I wanted to touch base with you on the upcoming release of our redistricting data.

I noticed on the TIGER website that the release date for states has been pushed back (release is now to start in December). Has the TIGER release also been pushed back for RDP participants?

I also wanted to see if a copy of our PL 94-171 data could also be sent
to
CityGate GIS for processing.

...Hope all is well with you and your family!

Thank you,

Tony
Tony J. Van Der Wielen
Legislative Technology Services Bureau
GIS Manager
Phone: 608-283-1817
Fax: 608-267-6763
E-mail: Tony.vanderwielen@legis.wisconsin.gov
Wisconsin Interactive Map Server: http://wims.legis.state.wi.us
Hi Tony,

I could use a refresher on how to print the maps. I'm having trouble printing the large size maps (can't get them to scale up) and I forgot how to take a portion of the map and blow it up and add it alongside the rest of the map.

Do you have a cheat sheet for that?

Thanks,

Tad

P.S. I know Adam has talked to you about the difficulty in switching districts, but it's become a real annoyance working on any new map. If I have to assign a new district from the toolbar, it crashes the program nearly every time once a map is filled with just a handful of districts.
Ryan,

This is a picture of what I get when autobound crashes on me. I was working on a map that has effectively 8 Assembly Districts assigned, I clicked on "current district" on the autobound tools to switch districts. The district numbers came up, when I clicked on the new district I wanted to move to, the program crashed and closed out and this popped up: (If form holds, this will happen on nearly every district switch using the toolbar the rest of the way until I have them all filled in and can left click between districts)
ArcGIS Desktop has encountered a serious application error and is unable to continue.

If you were in the middle of something, the information you were working on might be lost.

Please tell ESRI about this problem.

We have created an error report. Press the 'Send Error Report' button to send the error report to us automatically over the internet.

We will treat this report as confidential and anonymous.

Optionally, provide your email address and a description of the problem. We will contact you if we need additional information about this issue. Your email will only be used in relation to this issue.

Email Address:

What were you doing when the problem happened?

☑ Include my system information in the error report

Send Error Report  Don't Send
FW: How to Project the Plans

1 message

Ottman, Tad <Tad.Ottman@legis.wisconsin.gov>  Thu, Mar 17, 2011 at 11:51 AM
To: tottman@gmail.com

Original Message
From: Squires, Ryan
Sent: Thu 3/17/2011 11:39 AM
To: Ottman, Tad; Foltz, Adam
Cc: Van Der Wielen, Tony
Subject: How to Project the Plans

To Project Old AutoBound 9 Plan into AutoBound 10 Projection

1. Open ArcMap

2. Click File > Open, and navigate to the MXD inside the plan name found in your old Workspace folder (i.e. C:\Wisconsin\Workspace\Assembly\Assembly_2001). Open the MXD.

3. Open ArcToolbox inside of ArcMap

4. In ArcToolbox, click Data Management Tools > Projections and Transformations > Feature > Project

5. In the Project Tool, drag and drop 'Plan Boundary' from the Table of Contents into the Input Dataset or Feature Class. Click the Folder to navigate to an output location for the Shapefile.

6. For the Output Coordinate System, click the icon on the far right (looks like a pointing hand over a page). In Spatial Reference Properties, click Select > Geographic Coordinate Systems > North America > NAD 1983.prj. Click Add.

7. In the Geographic Transformation drop down, select NAD_1983_To_HARN_Wisconsin

8. Click Ok.

You will now be able to import the plans using the shapefiles in AutoBound. I believe you are both able to import shapefiles, but if you have any issues or would like a set of instructions please let me know.

Thanks!
Ryan Squires
GIS Analyst
Legislative Technology Services Bureau
608-283-1814
—Original Message—
From: Van Der Wielen, Tony
Sent: Thu 3/17/2011 1:53 PM
To: Foltz, Adam; Ottman, Tad
Subject: Field Calculations

Here is how the data was calculated.

1. Total Population = PERSONS
2. Hispanic Alone = Hispanic
3. Non-Hispanic White = White
4. Non-Hispanic Black + Non-Hispanic Black and White = Black
5. Non-Hispanic Asian + Non-Hispanic Asian and White = Asian
6. Non-Hispanic American Indian and Alaska Native + Non-Hispanic American Indian and Alaska Native and White = AMINDIAN
7. Non-Hispanic Native Hawaiian and Other Pacific Islander + Non-Hispanic Native Hawaiian and Other Pacific Islander and White = PISLAND
8. Non-Hispanic Some Other Race = OTHER
9. Non-Hispanic Other Multiple Race = OTHERMLT
10. Total Population over 18 = PERSONS18
11. 18 Hispanic Alone = Hispanic18
12. 18 Non-Hispanic White = White18
13. 18 Non-Hispanic Black + 18 Non-Hispanic Black and White = Black18
14. 18 Non-Hispanic Asian + 18 Non-Hispanic Asian and White = Asian18
15. 18 Non-Hispanic American Indian and Alaska Native + 18 Non-Hispanic American Indian and Alaska Native and White = AMINDIAN18

16. 18 Non-Hispanic Native Hawaiian and Other Pacific Islander + 18 Non-Hispanic Native Hawaiian and Other Pacific Islander and White = PISLAND18

17. 18 Non-Hispanic Some Other Race = OTHER18

18. 18 Non-Hispanic Other Multiple Race = OTHERMLT18

This is based on the DOJ Guidance that is attached to this e-mail.

If you add 2-9 together you will get 1 (Total Population).

If you add 11-18 you will get 10 (Persons18).

Let me know if you have any questions.

Thank you,

Tony

Tony J. Van Der Wielen
Legislative Technology Services Bureau
GIS Manager
Phone: 608-283-1817
Fax: 608-267-6763
E-mail: Tony.vanderwielen@legis.wisconsin.gov <mailto:Tony.vanderwielen@legis.wisconsin.gov>
Thursday,
January 18, 2001

Part XV

Department of Justice

Guidance Concerning Redistricting and Retrogression Under Section 5 of the Voting Rights Act, 42 U.S.C. 1973c; Notice
DEPARTMENT OF JUSTICE
Office of the Assistant Attorney General, Civil Rights Division;
Guidance Concerning Redistricting and Retrogression Under Section 5 of
the Voting Rights Act, 42 U.S.C. 1973c
AGENCY: Department of Justice.
ACTION: Notice.
SUMMARY: The Attorney General has delegated responsibility and authority
for determinations under Section 5 of
the Voting Rights Act to the Assistant
Attorney General, Civil Rights Division,
who finds that, in view of recent
judicial decisions, it is appropriate to
issue guidance concerning the review of
redistricting plans submitted to the
Attorney General for preclearance
pursuant to Section 5 of the Voting
Rights Act.
FOR FURTHER INFORMATION CONTACT:
Joseph D. Rich, Acting Chief, Voting
Section, Civil Rights Division, United
States Department of Justice,
Washington, D.C. 20530, (202) 514–
6018.
SUPPLEMENTARY INFORMATION: Section 5
of the Voting Rights Act of 1965, 42
U.S.C. 1973c, requires jurisdictions
covered by the Act’s special provisions
to obtain a determination from either
the Attorney General or the United
States District Court for the District of
Columbia that any change affecting
voting, which they seek to enforce, does
not have a discriminatory purpose and
will not have a discriminatory effect.
Beginning in April 2001, these
jurisdictions will begin to seek
preclearance of redistricting plans based
on the 2000 Census. Based on past
experience, the overwhelming majority
of the covered jurisdictions will submit
their redistricting plan to the Attorney
General. As part of the Department’s
preparation for the upcoming
redistricting cycle, Departmental
representatives conducted a nation-wide
outreach campaign in order to inform as
many of the interested parties as possible of the
manner in which it will analyze
redistricting plans under section 5.
Many of the contacts, both
governmental entities and interested
private citizens and groups, expressed
the view that, in view of recent judicial
decisions, it would be helpful for the
Department to issue some general
guidance in this area. These requests
coincided with the Attorney General’s
view that, by identifying, in general
terms, the Department’s analytical
approach, such guidance would serve a
useful law enforcement purpose. This
guidance is not legally binding; rather, it
is intended only to provide assistance
to entities and persons affected by
the preclearance requirements of section 5.
Approved OMB No. 1190–001 (expires
December 31, 2001).
Guidance Concerning Redistricting and
Retrogression Under Section 5 of the
Voting Rights Act, as Amended, 42
U.S.C. 1973c
Following release of the 2000 Census
data, the Department of Justice expects
to receive several thousand submissions of
redistricting plans pursuant to the
preclearance provisions in Section 5 of
The Civil Rights Division has received
numerous requests for guidance
concerning the procedures and
standards that will be applied during
review of these redistricting plans.
Many of the requests relate to the role
of the 2000 Census data in the Section 5
review process and to the Supreme
Court’s decisions in Shaw v. Reno, 509
U.S. 630 (1993), and later related cases.
The “Procedures for the
Administration of Section 5 of the
Voting Rights Act,” 28 CFR Part 51,
provide detailed information about the
Section 5 review process. Copies of these
procedures are available upon
request and through the Voting Section
Web site (http://www.usdoj.gov/crt/
voting).
This document is meant to
provide additional guidance with regard
to current issues of interest. Citations
to judicial decisions are provided to assist
the reader but are not intended to be
comprehensive. The following
discussion provides supplemental
guidance concerning the following
topics:
• The scope of Section 5 review;
• The Section 5 “benchmark”;
• how the benchmark plan is
  compared with the proposed plan;
• The considerations leading to the
decision to interpose a Section 5
  retrogression objection;
• racially discriminatory purpose
  under Section 5; and
• The use of 2000 Census data and
  other information during Section 5
  review.
The Scope of Section 5
The Supreme Court has held that
under Section 5, a covered jurisdiction
has the burden of establishing that a
proposed redistricting plan does not have
the purpose or effect of worsening the
position of minority voters when
compared to that jurisdiction’s
“benchmark” plan. Reno v. Bossier
Parish School Board, 120 S. Ct. 866,
871–72 (2000). If the jurisdiction fails to
show the absence of such purpose or
effect, then Section 5 preclearance will
be denied by the Department of Justice
or the District Court for the District of
Columbia.
The decision in the Bossier Parish
School Board case addressed the scope
of Section 5 review. Redistricting plans
that are not retrogressive in purpose or
effect must be precleared, even if they
violate other provisions of the Voting
Rights Act or the Constitution. The
Department of Justice may not deny
Section 5 preclearance on the grounds
that a redistricting plan violates the one-
person one-vote principle, on the
grounds that it violates Shaw v. Reno, or
on the grounds that it violates Section
2 of the Voting Rights Act. Therefore,
jurisdictions should not regard Section
5 preclearance of a redistricting plan as
preventing subsequent legal challenges
to that plan by the Department of
Justice. In addition, private plaintiffs
may initiate litigation, claiming either
constitutional or statutory violations.
Benchmark Plans
The last legally enforceable
redistricting plan in force for a Section
5 covered jurisdiction is the
“benchmark” against which a new plan is
compared. See 28 CFR 51.54(b)(1).
Generally, the most recent plan to have
received Section 5 preclearance (or have
been drawn by a federal court) is the last
legally enforceable redistricting plan for
Section 5 purposes. When a jurisdiction
has received Section 5 preclearance for
a new redistricting plan, or a federal
court has drawn a new plan and ordered
it into effect, that plan replaces the last
legally enforceable plan as the Section
5 benchmark. See McDaniel v. Sanchez,
452 U.S. 130 (1981); Texas v. United
States, 785 F. Supp. 201 (D.D.C. 1992);
Mississippi v. Smith, 541 F. Supp. 1329,
1333 (D.D.C. 1983), appeal dismissed,
In Abrams v. Johnson, 521 U.S. 74
(1997), the Supreme Court held that a
redistricting plan found to be
unconstitutional under the principles of
Shaw v. Reno and its progeny could not
serve as the Section 5 benchmark. Therefore,
a redistricting plan drawn to
replace a plan found by a federal court
to violate Shaw v. Reno will be
compared with the last legally
enforceable plan predating the
unconstitutional plan. Absent such a
finding of unconstitutionality under
Shaw v. Reno, the last legally
enforceable plan will serve as the
benchmark for Section 5 review.
Therefore, a jurisdiction is not required
to address the constitutionality of its
benchmark plan when submitting a
redistricting plan and the question of
whether the benchmark plan is
constitutional will not be considered.
during the Department's Section 5 review.

Comparison of Plans

When the Department of Justice receives a Section 5 redistricting submission, several basic steps are taken to ensure a complete review. After the "benchmark" districting plan is identified, the staff inputs the boundaries of the benchmark and proposed plans into the Civil Rights Division's geographic information system. Then, using the most recent decennial census data, population data are calculated for each of the districts in the benchmark and proposed plans.

Division staff then analyzes the proposed plan to determine whether it will reduce minority voting strength when compared to the benchmark plan, considering all of the relevant, available information. Although comparison of the census population data of the benchmark and proposed plans is the important starting point of any retrogression analysis, our review and analysis will be greatly facilitated by inclusion of additional demographic and election data in the submission. See 28 CFR 51.28(a). For example, census population data may not reflect significant differences in group voting behavior. Therefore, election history and voting patterns within the jurisdiction, voter registration and turnout information, and other similar information are very important to an assessment of the actual effect of a redistricting plan. This information is used to compare minority voting strength in the benchmark plan as a whole with minority voting strength in the proposed plan as a whole.

The Section 5 Procedures identify a number of factors that are considered in deciding whether or not a redistricting plan has a retrogressive purpose or effect. These factors include whether minority voting strength is reduced by the proposed redistricting; whether minority concentrations are fragmented among different districts; whether minorities are overconcentrated in one or more districts; whether available alternative plans satisfy the jurisdiction's legitimate governmental interests were considered; whether the proposed plan departs from objective redistricting criteria set by the submitting jurisdiction, ignores other relevant factors such as compactness and contiguity, or displays a configuration that inexplicably disregards available natural or artificial boundaries; and, whether the plan is inconsistent with the jurisdiction's stated redistricting standards. See 28 CFR 51.59; see also 28 CFR 51.56-51.58.

A proposed plan is retrogressive under the Section 5 "effect" prong if its net effect would be to reduce minority voter's "effective exercise of the electoral franchise" when compared to the benchmark plan. See Beer v. United States, 425 U.S. 130, 141 (1976). The effective exercise of the electoral franchise usually is assessed in redistricting submissions in terms of the opportunity for minority voters to elect candidates of their choice. The presence of racially polarized voting is an important factor considered by the Department of Justice in assessing minority voting strength. A proposed redistricting plan ordinarily will occasion an objection by the Department of Justice if it appears that the plan has reduced minority voting strength relative to the benchmark plan and a fairly-drawn alternative plan could ameliorate or prevent that retrogression.

Alternatives to Retrogressive Plans

If a retrogressive redistricting plan is submitted, the jurisdiction seeking preclearance of such a plan bears the burden of demonstrating that a less-retrogressive plan cannot reasonably be drawn. In analyzing this issue, the Department takes into account constitutional criteria discussed below, the residential segregation and distribution of the minority population within the jurisdiction, demographic changes since the previous redistricting, the physical geography of the jurisdiction, the jurisdiction's historical redistricting practices, political boundaries such as cities and counties, and state redistricting requirements.

In considering whether less-retrogressive alternative plans are available, the Department of Justice looks to plans that were actually considered or drawn by the submitting jurisdiction, as well as alternative plans presented or made known to the submitting jurisdiction by interested citizens or others. In addition, the Department may develop illustrative alternative plans for use in its analysis, taking into consideration the jurisdiction's redistricting principles. If it is determined that a reasonable alternative plan exists that is non-retrogressive or less retrogressive than the submitted plan, the Department will interpose an objection.

Preventing retrogression under Section 5 does not require jurisdictions to violate the one-person one-vote principle. See 52 FR 488 (Jan. 6, 1987). Similarly, preventing retrogression under Section 5 does not require jurisdictions to violate Shaw v. Reno and related cases.

The one-person one-vote issue arises most commonly where substantial demographic changes have occurred in some, but not all, parts of a jurisdiction. Generally, a plan for congressional redistricting that would require a greater overall population deviation than the submitted plan is not considered a reasonable alternative by the Department. For state legislative and local redistricting, a plan that would require overall population deviations greater than 10 percent is not considered a reasonable alternative.

In assessing whether a less retrogressive alternative plan can reasonably be drawn, the geographic compactness of a jurisdiction's minority population will be a factor in the Department's analysis. This analysis will include a review of the submitting jurisdiction's historical redistricting practices and district configurations to determine whether the alternative plan would (a) abandon those practices and (b) require highly unusual features to link together widely separated minority concentrations.

At the same time, compliance with Section 5 of the Voting Rights Act may require the jurisdiction to depart from strict adherence to certain of its redistricting criteria. For example, criteria which require the jurisdiction to make the least change to existing district boundaries, follow county, city, or precinct boundaries, protect incumbents, preserve partisan balance, or in some cases, require a certain level of compactness of district boundaries may need to give way to some degree to avoid retrogression. In evaluating alternative plans, the Department of Justice relies upon plans that make the least departure from a jurisdiction's stated redistricting criteria needed to prevent retrogression.

Prohibited Purpose

In those instances in which a plan is found to have a retrogressive effect, as well as in those cases in which a proposed plan is alleged to have a retrogressive effect but a functional analysis does not yield clear conclusions about the plan's effect, the Department of Justice will closely examine the process by which the plan
was adopted to ascertain whether the plan was intended to reduce minority voting strength. This examination may include consideration of whether there is a purpose to retrogress in the future even though there is no retrogression at the time of the submission. If the jurisdiction has not provided sufficient evidence to demonstrate that the plan was not intended to reduce minority voting strength, either now or in the future, the proposed redistricting plan is subject to a Section 5 objection.

The 2000 Census

The most current population data are used to measure both the benchmark plan and the proposed redistricting plan. See 28 CFR 51.54(b)(2) (Department of Justice considers “the conditions existing at the time of the submission”). City of Rome v. United States, 446 U.S. 156, 186 (1980) (“most current available population data” to be used for measuring effect of annexations); Reno v. Bossier Parish School Board, 120 S. Ct. at 874 (“In § 5 preclearance proceedings • • • the baseline is the status quo that is proposed to be changed: If the change ‘abridges the right to vote’ relative to the status quo, preclearance is denied • • •”).

For redistricting after the 2000 Census, the Department of Justice will, consistent with past practice, evaluate redistricting submissions using the 2000 Census population data released by the Bureau of the Census for redistricting pursuant to Public Law 94–171, 13 U.S.C. 141(c). Thus, our analysis of the effect of proposed redistricting plans includes a review and assessment of the Public Law 94–171 population data, even if those data are not included in the submission or were not used by the jurisdiction in drawing the plan. The failure to use the Public Law 94–171 population data in redistricting does not, by itself, constitute a reason for denial of preclearance. However, unless other population data can be shown to be more accurate and reliable than the Public Law 94–171 data, the Department of Justice will consider the Public Law 94–171 data to measure the total population and voting age population within a jurisdiction for purposes of its Section 5 analysis.

<table>
<thead>
<tr>
<th>Total population</th>
<th>662,140</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Hispanic</td>
<td>649,413 (98.1%)</td>
</tr>
<tr>
<td>White</td>
<td>374,291 (56.5%)</td>
</tr>
<tr>
<td>Black or African American</td>
<td>282,364 (39.6%)</td>
</tr>
<tr>
<td>Asian</td>
<td>6,161 (0.9%)</td>
</tr>
<tr>
<td>American Indian/Alaska Native</td>
<td>2,995 (0.5%)</td>
</tr>
<tr>
<td>Native Hawaiian or Other Pacific Islander</td>
<td>375 (0.5%)</td>
</tr>
<tr>
<td>Some other race</td>
<td>882 (0.1%)</td>
</tr>
<tr>
<td>Hispanic</td>
<td>2,330 (0.4%)</td>
</tr>
<tr>
<td>Other Multiple-Race (where more than one minority race is listed)</td>
<td>12,727 (1.9%)</td>
</tr>
</tbody>
</table>

Pursuant to Part II of OMB Bulletin 00–02, any multiple-race response that included white and one of the five other race categories was allocated to the minority race listed in the response. Thus, the numbers above for Black/African American, Asian, American Indian/Alaska Native, Native Hawaiian or Other Pacific Islander and Some other race reflect the total of the single race responses and the multiple-race responses in which the minority race and white race were listed. For example, for the Black/African American category, there were 261,142 single race responses and 1,242 multiple-race responses in which the races listed were White and Black/African American. This adds up to the total calculated above of 262,384.

The Other Multiple-Race category is comprised of all multiple-race responses where there is more than one minority race listed. The number above (2,330) reflects the total number of responses of forty two such categories in the Columbia data where at least one response was indicated. In our analysis, we will examine this multiple-race data and if it appears that any one of these categories has significant numbers of responses (for example, if the Black/African American and American Indian/Alaska Native category, alone, indicates a significant number of responses), those responses will be allocated alternatively to each of the component single-race categories for analysis, as indicated in Part II of the OMB Bulletin. It is important to note that current research indicates that multiple-race responses are expected to be small. This is especially true with respect to multiple-race categories with two or more minority races. For example, in the single-race data, the largest such groups are only 0.1 percent of the population (American Indian/Alaska Native and Black/African American; and Asian and Black/African American). In light of this, the impact of such multiple-race responses on the Department of Justice’s analysis of census data pursuant to its responsibilities under the Voting Rights Act is expected to be minimal.

As in the past, the Department will analyze Hispanic voters as a separate group for purposes of enforcement of the Voting Rights Act. If there are significant numbers of responses which report Hispanics and one or more minority races (for example, Hispanics who list their race as Black/African-American), those responses will be allocated alternatively to the Hispanic category and the minority race category.


Bill Lann Lee, Assistant Attorney General, Civil Rights Division.

[FR Doc. 01–1486 Filed 1–17–01; 8:45 am]

BILLING CODE 4410–13–P
<table>
<thead>
<tr>
<th>Year</th>
<th>Senate Seats</th>
<th>Dem Inc</th>
<th>GOP Inc</th>
<th>Dem Uncontested</th>
<th>GOP Uncontested</th>
<th>Third Party</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>17</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>19</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>21</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>27</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>29</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>31</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>33</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>2008</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>14</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>18</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>22</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>24</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>26</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>28</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>30</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>32</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2006</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>17</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>19</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>21</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>25</td>
<td>27</td>
<td>29</td>
<td>31</td>
<td>33</td>
</tr>
<tr>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2004</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>16</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>18</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>20</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>22</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>24</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>26</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>28</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>30</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>32</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2002</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>17</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>19</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>21</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>23</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>25</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>27</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>29</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>31</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>33</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>
Wisconsin Hispanic Districts

tottman <tottman@gmail.com>  Sun, Jul 17, 2011 at 11:40 AM
To: Keith Gaddie <rggaddie@ou.edu>
Cc: adam foltz <adamfoltz@gmail.com>, Jim Troupis <jrtroupis@trouplawoffice.com>, "McLeod, Eric M (22257)" <EMMcleod@michaelbest.com>, "Taffora, Raymond P (22244)" <rptaffora@michaelbest.com>

Keith,

Jim Troupis asked that I have you take a look at the amendment that was adopted in committee on the hispanic districts. Here is the link to the interactive maps: http://legis.wisconsin.gov/ltsb/redistricting/bills.htm

Amendment 2 was the configuration that was adopted. The HVAP in AD 8 is 60.5 % and in AD 9 it is 54%. The incumbent lives in AD 8 and AD 9 is open under all alternatives.

There was testimony by 2 different hispanic groups in favor of the configuration in amendment 2. No one that I'm aware of testified in favor of either the bill configuration (AD 8 HVAP 57.2%, AD 9 HVAP 57.2%) or in favor of amendment 1 (AD 8 HVAP 64%, AD 9 HVAP 50%).

Jim was going to call you later today to get your thoughts if you have a chance to take a look at the amendment.

Thanks,

Tad Ottman
Wisconsin Hispanic Districts

Gaddie, Ronald K. <rggaddie@ou.edu>  Sun, Jul 17, 2011 at 1:18 PM
To: tottman <tottman@gmail.com>
Cc: adam foltz <adamfoltz@gmail.com>, Jim Troupis <jtroupis@troupislawoffice.com>, "McLeod, Eric M (22257)"
<EMMcleod@michaelbest.com>, "Taffora, Raymond P (22244)" <rttaffora@michaelbest.com>

I will look at them and can talk after 5pm. There are other items I need to clear off the desk before I am free to visit.

Ronald Keith Gaddie
Professor of Political Science
Editor, Social Science Quarterly
The University of Oklahoma
455 West Lindsey Street, Room 222
Norman, OK 73019-2001
Phone 405-325-4989
Fax 405-325-0718
E-mail: rkgaddie@ou.edu
http://faculty-staff.ou.edu/G/Ronald.K.Gaddie-1
http://socialsciencequarterly.org
Revised timing
2 messages

Gaddie, Ronald K. <rggaddie@ou.edu>  Sun, Jul 17, 2011 at 1:33 PM
To: tottman <tottman@gmail.com>
Cc: adam foltz <adamfoltz@gmail.com>, Jim Troupis <jtroupis@troupislawoffice.com>, "McLeod, Eric M (22257)"
<EMMcleod@michaelbest.com>, "Taffora, Raymond P (22244)" <rptaffora@michaelbest.com>

I am ready to talk.

Ronald Keith Gaddie
Professor of Political Science
Editor, Social Science Quarterly
The University of Oklahoma
455 West Lindsey Street, Room 222
Norman, OK 73019-2001
Phone 405-325-4989
Fax 405-325-0718
E-mail: rggaddie@ou.edu
http://faculty-staff.ou.edu/G/Ronald.K.Gaddie-1
http://socialsciencequarterly.org

From: tottman [tottman@gmail.com]
Sent: Sunday, July 17, 2011 11:40 AM
To: Gaddie, Ronald K.
Cc: adam foltz; Jim Troupis; McLeod, Eric M (22257); Taffora, Raymond P (22244)
Subject: Wisconsin Hispanic Districts

Keith,

Jim Troupis asked that I have you take a look at the amendment that was adopted in committee on the hispanic districts. Here is the link to the interactive maps: http://legis.wisconsin.gov/ltsb/redistricting/bills.htm

Amendment 2 was the configuration that was adopted. The HVAP in AD 8 is 60.5 % and in AD 9 it is 54%. The incumbent lives in AD 8 and AD 9 is open under all alternatives.

There was testimony by 2 different hispanic groups in favor of the configuration in amendment 2. No one that I'm aware of testified in favor of either the bill configuration (AD 8 HVAP 57.2%, AD 9 HVAP 57.2%) or in favor of amendment 1 (AD 8 HVAP 64%, AD 9 HVAP 50%).

Jim was going to call you later today to get your thoughts if you have a chance to take a look at the amendment.

Thanks,

Tad Ottman
I can call you now if you would like. On the cell? Or after 5 if you would like.

James R. Troupis
Troupis Law Office LLC
jrtroupis@troupislawoffice.com

ph. 608-807-4096

This email and any attachments thereto may contain private, confidential and privileged material for the sole use of the intended recipient. Any review, copying, or distribution of this email (or any attachments thereto) by others is strictly prohibited. If you are not the intended recipient, please contact the sender immediately and permanently delete the original and any copies of this email and any attachments thereto.

From: Gaddie, Ronald K. [mailto:rggaddie@ou.edu]
Sent: Sunday, July 17, 2011 1:33 PM
To: totman
Cc: adam foltz; Jim Troupis; McLeod, Eric M (22257); Taffora, Raymond P (22244)
Subject: Revised timing

I am ready to talk.

Ronald Keith Gaddie
Professor of Political Science
Editor, Social Science Quarterly
The University of Oklahoma
455 West Lindsey Street, Room 222
Norman, OK 73019-2001
Phone 405-325-4989
Fax 405-325-0718

E-mail: rkgaddie@ou.edu
http://faculty-staff.ou.edu/G/Ronald.K.Gaddie-1
http://socialsciencequarterly.org
To: Gaddle, Ronald K.  
Cc: adam foltz; Jim Troupis; McLeod, Eric M (22257); Taffora, Raymond P (22244)  
Subject: Wisconsin Hispanic Districts  

Keith,

Jim Troupis asked that I have you take a look at the amendment that was adopted in committee on the hispanic districts. Here is the link to the interactive maps:  http://legis.wisconsin.gov/itsb/redistricting/bills.htm

Amendment 2 was the configuration that was adopted. The HVAP in AD 8 is 60.5% and in AD 9 it is 54%. The incumbent lives in AD 8 and AD 9 is open under all alternatives.

There was testimony by 2 different hispanic groups in favor of the configuration in amendment 2. No one that I'm aware of testified in favor of either the bill configuration (AD 8 HVAP 57.2%, AD 9 HVAP 57.2%) or in favor of amendment 1 (AD 8 HVAP 64%, AD 9 HVAP 50%).

Jim was going to call you later today to get your thoughts if you have a chance to take a look at the amendment.

Thanks,

Tad Ottman
Alternative ADs 8 and 9.pdf
106K

tottman <tottman@gmail.com> To: scottjensen@wi.rr.com
Fri, Jul 8, 2011 at 5:07 PM

Scott,

Rich Zipperer mentioned he had been talking to you about the Hispanic districts in Milwaukee. I wanted to get to you a shapefile of the amendment with an alternative configuration of the 2 districts that was introduced along with the bill on legislative districts. There is a link to the interactive map of the full state map below.

Let me know if you have any questions.

Thanks,

Tad Ottman

LTSB has started to post the redistricting information on its site, which can be found at:

http://legis.wisconsin.gov/ltsb/redistricting/bills.htm

Alternative ADs 8 and 9.pdf
106K
Tad,

Thanks.

Scott

<Alternative ADs 8 and 9.pdf>

Fri, Jul 8, 2011 at 10:24 PM

Scott Jensen <scottjensen@wi.rr.com>
To: Jesus Rodriguez <zeus@rodriguezwi.com>
Cc: tottman <tottman@gmail.com>

Zeus,

Here is an alternative map for the two Hispanic districts. The original map can be found at the state link below. You can contact Tad Ottman for an explanation of both options at the address above. Also, you can contact Joe Handrick at 608-215-5837. Thanks.

Scott

Begin forwarded message:

From: tottman <tottman@gmail.com>
Date: July 8, 2011 5:07:53 PM CDT
To: scottjensen@wi.rr.com
Subject: Fwd: Alternative Confitureation of ADs 8 and 9

---

Alternative ADs 8 and 9.pdf
106K

Sat, Jul 9, 2011 at 7:14 AM

Jesus Rodriguez <zeus@rodriguezwi.com>
To: Scott Jensen <scottjensen@wi.rr.com>
Cc: tottman <tottman@gmail.com>

Thanks Scott.

Hello Tad,
Thank you for helping me in this process. What I really need is a comparison of the new maps (both versions of 8 and 9) and the current map. Along with the actual demographics and percentages (both general and Voting Age Populations) of the new and old districts. Preferably in PDF, so that I can make hard copies.

Do both Zepnik and Zamarripa live in these two new versions?

If I am going to be able to testify as soon as Wednesday, time is of the essence, especially if we are going to make any recommendations. You can feel free to call me on my cell phone 414-745-6676. If you think it would be more efficient to bring Joe Handrick in as well, I will call him too.

Thank you very much,

Zeus

<Alternative ADs 8 and 9.pdf>

Sat, Jul 9, 2011 at 5:21 PM

*ottman <ottman@gmail.com>*

Cc: Jesus Rodriguez <zeus@rodriguezwi.com>

Here are maps of the seats under the bill as introduced (with the current district overlayed on top) as well as the amendment. The third file is some statistics on the districts. We are still working on heat maps at this time.

3 attachments

- AD 8 and 9 as introduced.pdf
  96K
- Amended Hispanic Districts.pdf
  86K
- Hispanic seats.pdf
  95K

Sat, Jul 9, 2011 at 5:34 PM

RodriguezWI <zeus@rodriguezwi.com>

To: ottman <ottman@gmail.com>

Thank you. I look forward to the rest of the maps.

Agnus Dei, qui tollis peccata Mundi.

<AD 8 and 9 as introduced.pdf>

<Amended Hispanic Districts.pdf>
tottman <tottman@gmail.com>  
Sat, Jul 9, 2011 at 7:41 PM

Here is the Milwaukee heat map.

Hispanic Voting Age Population - Heat Map.pdf
442K

tottman <tottman@gmail.com>  
Sat, Jul 9, 2011 at 7:43 PM

To: Scott Jensen <scottjensen@wi.rr.com>

Scott,

If you could give me a call at your convenience I'd appreciate it. I'm home the rest of the night at 608.827.0527 or you can reach me tomorrow at 608.258.2291.

Thanks,

Tad

Jes Rodriguez <zeus@rodriguezwi.com>  
Sat, Jul 9, 2011 at 8:15 PM

To: tottm <tottman@gmail.com>

Outstanding, this is very helpful.

Could we please get this heat map with the current district lines and also the second proposed map?

I hate to sound so demanding, I know you are working overtime. If it's any consolation, I own 2 businesses and run one non profit, while doing this redistricting stuff for free.

I will also like to have heat maps for the proposed Waukesha city, Racine city and Madison districts, where the Hispanic community is also growing significantly. These maps can come after the ones above.

Last but not least when and who do I speak with about making actual changes to the proposal? I spoke with Joe and he said that we would be able to work with someone.

Thank you so much for your hard work!

Zeus

Hispanic Voting Age Population - Heat Map.pdf

tottman <tottman@gmail.com>  
Mon, Jul 11, 2011 at 9:54 AM
To: Jesus Rodriguez <zeus@rodriguezwi.com>

Here are the heat maps with the current district overlay and with the amendment overlay.

In terms of a contact for information about changes to the proposal, you should contact Ray Taffora with Michael Best & Friedrich. His number is 608.283.2244.

Thanks,

Tad

2 attachments

Hispanic Voting Age Population - Heat Map - Current District Overlay.pdf
438K

Hispanic Voting Age Population - Heat Map - Amendment Overlay.pdf
446K

---

tottman <tottman@gmail.com>  
To: Jesus Rodriguez <zeus@rodriguezwi.com>  
Mon, Jul 11, 2011 at 2:23 PM

Here are the heat maps for Racine, Waukesha and Madison with both the current district and the proposed maps as overlays.

6 attachments

Racine HVAP Current District.pdf
60K

Racine HVAP LRB 2261.pdf
61K

Waukesha HVAP Current District.pdf
100K

Waukesha HVAP LRB 2261.pdf
103K

Madison HVAP Current District.pdf
106K

Madison HVAP LRB 2261.pdf
111K

---

tottman <tottman@gmail.com>  
To: Jesus Rodriguez <zeus@rodriguezwi.com>  
Mon, Jul 11, 2011 at 6:23 PM

I wanted to get you one more proposal to look at. This alternative has AD 8 with 60.5 HVAP and AD 9 with 54.03 HVAP. I've overlayed the current district outlines on top.

AD 8 and 9 alternative with current overlay.pdf
59K
Hi Tad,

I emailed Fred and his support staff this morning about the 3 issues (Overlapping Population Error, Zero Area Plan Errors, and the Current District/Active Layer pop up application crash) that Adam and I discussed this morning. I will keep on them today to try to get a response in a reasonable amount of time this time.

I will write up a quick instructional sheet for you on how to create an inset, and how to set up a large scale (34"x44" ANSI E) print. If you would like me to just call you and walk you through the process I would be happy to do that as well, just let me know.

Please let me know if either of you have any additional questions.

Thanks,

Ryan

From: tottman [mailto:tottman@gmail.com]
Sent: Tuesday, May 03, 2011 10:05 AM
To: Van Der Wielen, Tony
Subject: Map printing assistance

Hi Tony,

I could use a refresher on how to print the maps. I'm having trouble printing the large size maps (can't get them to scale up) and I forgot how to take a portion of the map and blow it up and add it alongside the rest of the map.

Do you have a cheat sheet for that?

Thanks,

Tad

P.S. I know Adam has talked to you about the difficulty in switching districts, but it's become a real annoyance working on any new map. If I have to assign a new district from the toolbar, it crashes the program nearly every time once a map is filled with just a handful of districts.
To Adjust the Page Size and Layout:

1. Click File > Page and Print Setup
2. In Page and Print Setup, under Printer Setup select the name of the printer or plotter
   a. To adjust specific Printer settings (such as Plotter Print Quality), click Properties under Printer Setup.
      i. In the Plotter Properties, click the Paper/Quality tab. In this tab, the Print Quality can be set to a higher quality (Best), Maximum Detail can be enabled, and the specific plotter roll can be chosen
3. In Page and Print Setup, under Paper, select the Paper Size (ANSI E is the poster size), and orientation of the map.

To Adjust the Data Frame (Map Viewing Window) to a New Paper Size:

1. Click View > Layout View. The outer box represents the actual page. The dotted lines just inside the outer box represent the printable area of the page. The area where the map is actually visible is the Data Frame, or the area where your data will be visible.
2. Click Customize > ArcMap Options > Layout View tab. Check “Margins” under “Snap Elements To:”. Click Ok. This will allow you to drag the data frame’s corners in Layout View to the dotted lines, or margins of the printable area.
3. Click on the Data Frame (By default, it is called Layers and should highlight with blue anchor squares in the corners and edges). Drag the corner squares to the dotted line to maximize the data that can be displayed on the page. You can adjust the data frame however you want with other map objects, but anything that hangs over the dotted line will not be part of the print. I recommend exporting to PDF before printing to confirm that the map is not being cut off, and then print directly from the PDF.

To Create an Inset:

1. In Layout View, click Insert > Data Frame. A new Data Frame should appear in the middle of the screen.
2. Drag and drop any layers you want to see in the inset under the “New Data Frame” header in the Table of Contents.
3. Right click the new data frame header in the Table of Contents > Click Activate.
4. Click View > Data View. In Data View, you should be viewing the inset’s data. Zoom to the area approximately where you want the inset to show.
5. Click View > Layout View. In Layout View, the new data frame should still be activated (you can tell what data frame is activated if the data frame header in the
table of contents is bold). Use the normal zoom and pan tools to adjust the exact data that is visible in the inset. You can also use the blue anchors to adjust the exact size and location of the inset within the layout view.

This has been a very brief summary of the process, so if you need any additional instruction, or would like someone to come over and go through a refresher with you, please just let me know.

Thanks!

Ryan

Ryan Squires
GIS Analyst
Legislative Technology Services Bureau
608-283-1814
Hi Tad,

If you create a new map document, add any random layer in it through Add Data, and go to layout view, can you adjust the data frame?

Ryan Squires
GIS Analyst
Legislative Technology Services Bureau
608-283-1814
Hi Tad,

`sounds like the program had noticed an error due to the spatial editing process, and once you told it to fix itself, it was just letting you know that it recompiled. So based on the messages below it sounds like the problem was already corrected.

My best guess as to what is most likely happening is that there were block polygons that were grabbed during they overlay process because they were bordering the edge of the overlay polygon. When the program verified with the block point file to accumulate the population totals it found that those polygons on the edge were not meant to be grabbed and it was letting you know that it wanted to fix it and was asking permission, then letting you know the area was corrected. I can verify with Fred that my hypothesis is correct, but as I said, it sounds like the program has already corrected the issue.

Please let me know if you have any questions.

Thanks,

Ryan

From: tottman [mailto:tottman@gmail.com]
Sent: Thursday, May 19, 2011 6:04 PM
To: Van Der Wielen, Tony
Subject: autobound errors

Tony,

I'm running into the same problem Adam was earlier. I am assigning districts by overlay and I get a message such as:

District 74 is inconsistent!
768 Boundary Polygons vs. 765 Attribute Polygons. Click OK to FIX!

Then it does it and I get this:

For District: 74 The area was 1.920666911865 and was verified to be 1.87974763251698

This has happened to be both assigning by overlay at the block level and manual assigning CCD's at the CCD level.
Any thoughts on how to correct?

Thanks,

Tad